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Abstract: Urban air pollution poses a significant threat to human health, with metropolitan areas
particularly affected due to high emissions from human activities. Particulate matter (PMx) is among
the most harmful pollutants to human health, being composed of a complex mixture of substances
related to severe pulmonary conditions. Urban green spaces play a vital role in mitigating air pollution
by capturing PMx, and it is essential to select plant species with a high capacity for PMx accumulation
to effectively enhance air quality. This study aimed to evaluate and compare the accuracy of two PMx

quantification methods—light microscopy and filtration—which demonstrated a high correlation
(R2 = 0.72), suggesting that both methods are reliable for assessing PMx accumulation on leaves. Light
microscopy allowed for the visualization of PMx deposition, revealing the species warranting further
analysis using the filtration method. Among the species analyzed, Euonymus japonicus, Ligustrum
lucidum, Alnus glutinosa, Rubus ulmifolius, and Laurus nobilis demonstrated the highest total PMx

accumulation, exceeding 50 µg cm−2, making them particularly valuable for air pollution mitigation.
This study examined the correlation between leaf traits such as specific leaf area (SLA), leaf area (LA),
leaf dissection index (LDI), and leaf roundness and PMx accumulation across the 30 different plant
species. A multiple linear regression analysis indicated that these leaf traits significantly influenced
PMx accumulation, with SLA and LA showing negative correlations and leaf roundness exhibiting
a positive correlation with PMx deposition. In conclusion, this study highlights the importance
of selecting plant species with specific leaf traits for effective air quality improvement in urban
environments particularly in highly polluted areas, to enhance air quality and public health.

Keywords: PMx quantification; leaf traits; air pollution mitigation; urban green

1. Introduction

Urban air pollution is a threat to human health. Air quality is generally worse in
metropolitan areas due to high emissions from human activities [1]. A substantial portion
of people live in cities where air quality limits are frequently exceeded, adversely affecting
people’s quality of life. Particulate matter (PMx), nitrogen dioxide (NO2), and ground-level
ozone (O3) are the most harmful pollutants to human health in Europe. For instance, in
Italy, air pollution is approximately related to 62,000 deaths yearly [2].

PMx is defined as a complex mixture of saturated solutions and solid substances,
including heavy metals, unburned black carbon particles, polycyclic aromatic hydrocar-
bons (PAH), and other suspended constituents [3]. PMx can originate from natural or
anthropogenic processes, with fossil fuel combustion from vehicles, building heating, and
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industrial and agricultural activities being the primary sources in urban environments [4,5].
Atmospheric PMx is classified based on the diameter of its particles: PM10 (≤10 µm), PM2.5
(≤2.5 µm), and PM0.2 (≤0.2 µm) [6], with its accumulation on leaves depending on particle
properties. Most of the total particle number accumulated on leaves is smaller than 2.5 µm.
These small particles are particularly harmful to human health, as they can penetrate the
respiratory system, causing severe pulmonary conditions. Larger particles can absorb toxic
materials due to their shape and size [7].

Urban green reduces air pollution by capturing PMx [8], serving as biological barri-
ers along roads, high-traffic avenues, and streets [9], providing an effective solution for
reducing urban air pollution. Efforts have been made to estimate the amount of pollutants
removed by plants globally. For example, one hectare of urban tree cover in the United
States removes about 67 kg of pollution annually [10]. In Britain, it was estimated that
natural urban green spaces removed 28,700 tonnes of pollutants (PM2.5, NO2, SO2, and O3)
in 2015, resulting in 900 fewer respiratory hospital admissions, 220 fewer cardiovascular
hospital admissions, 240 fewer deaths, and 3600 fewer Life Years Lost [8].

Particle features such as size, shape, and composition influence the deposition mecha-
nism on leaves and are crucial for predicting regional pollutant concentrations [11]. Under-
standing the impact of leaf morphology on PMx accumulation is essential for elucidating
the differential capacities among species to facilitate PMx deposition [12]. Selecting plant
species to improve air quality at vulnerable urban sites is fundamental before planning
and designing efficient pollution-mitigating interventions [13]. Additionally, site-specific
conditions such as traffic density, the presence of buildings, atmospheric stability, and wind
angle must be considered for the effectiveness of urban green projects in improving air
quality [11].

Several studies quantify PMx accumulation on leaves using different approaches.
Two common methods are (1) light microscopical analysis, which allows for an accurate
visualization of PMx deposition, and (2) filtration methods, which determine different
classes of PMx. However, the criteria for choosing between methods can be problematic,
as the correlation between the results of different approaches is not often demonstrated
or discussed.

There remains a significant need to identify and characterize plant species that are
particularly efficient at accumulating PMx, as these species could play a crucial role in
mitigating urban air pollution. The efficiency of PMx accumulation varies widely among
plant species, and this variation can largely be explained by differences in specific leaf
traits. Morphological characteristics, such as leaf shape, size, and surface roughness, have
been shown to influence the ability of leaves to capture and retain particles. For instance,
species with more complex leaf shapes and greater surface area often exhibit higher PMx
accumulation, as their surfaces provide more opportunities for particles to adhere [14,15].

In addition to morphology, structural features of the leaf, particularly the composition
and thickness of epicuticular waxes, play a pivotal role in determining a plant’s capacity
to accumulate PMx. Waxes can act as a sticky layer, trapping PMx on the leaf surface and
preventing it from being resuspended into the atmosphere. Research has demonstrated
that species with thicker or more abundant wax layers tend to accumulate higher quantities
of PMx, making wax deposition a key trait in the identification of efficient accumulator
species [15,16]. Furthermore, physiological traits such as stomatal density, distribution, and
function can also impact PMx capture, as stomata can either facilitate the internal deposition
of smaller particles or be obstructed by PMx, thereby affecting gas exchange processes.

Together, these leaf traits—morphological, structural, and physiological—offer a com-
prehensive framework for understanding the mechanisms behind PMx accumulation and
provide valuable criteria for selecting plant species that can effectively improve air quality
in urban environments.

This study aimed to evaluate and compare two distinct PMx quantification methods,
hypothesizing a high correlation between them. To achieve this, we designed a comprehen-
sive research framework focused on testing these methods’ reliability and applicability in
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investigating PMx accumulation on leaves. Furthermore, this study sought to determine
the correlation between various leaf traits and PMx accumulation across different plant
species. Our research questions centered on the following: (1) How accurate are the two
selected PMx quantification methods? (2) Which method is more suitable for different
research objectives related to PMx accumulation? (3) What is the correlation between leaf
traits and PMx accumulation in diverse plant species?

2. Material and Methods
2.1. Study Area

The study was conducted in the province of Lucca, Tuscany, Italy. This region ex-
periences high PMx levels due to a combination of factors, including the dispersion of
air pollutants hindered by adverse weather conditions such as low wind regimes, stable
atmospheric conditions, and shallow thermal inversions [17].

2.2. Plant Species

The thirty species chosen within the investigated area are listed in Table 1.

Table 1. Detailed classification of the 30 studied plant species.

Species Family Name Type of Plant

Acer campestre L. Sapindaceae Tree
Acer negundo L. Sapindaceae Tree
Acer saccharinum L. Sapindaceae Tree
Alnus glutinosa (L.) Gaertn. Betulaceae Tree
Celtis australis L. Cannabaceae Tree
Euonymus japonicus Thunb. Celastraceae Shrub
Forsythia viridissima Lindl. Oleaceae Shrub
Gaultheria procumbens L. Ericaceae Shrub
Ginkgo biloba L. Ginkgoaceae Tree
Impatiens walleriana Hook.f. Balsaminaceae Herb
Laurus nobilis L. Lauraceae Shrub
Lavandula latifolia Medik. Lamiaceae Shrub
Ligustrum lucidum W.T. Aiton Oleaceae Tree
Nerium oleander L. Apocynaceae Shrub
Olea europaea L. Oleaceae Tree
Populus alba L. Salicaceae Tree
Populus nigra L. Salicaceae Tree
Prunus domestica L. Rosaceae Tree
Prunus laurocerasus L. Rosaceae Tree
Prunus serrulata Lindl. Rosaceae Tree
Quercus ilex L. Fagaceae Tree
Rosa chinensis Jacq. Rosaceae Shrub
Rubus ulmifolius Schott Rosaceae Shrub
Salix cinerea L. Salicaceae Shrub or tree
Styphnolobium japonicum (L.) Schott Fabaceae Tree
Tilia x europaea L. Malvaceae Tree
Tilia cordata Mill. Malvaceae Tree
Ulmus minor Mill. Ulmaceae Tree
Ulmus glabra Huds. Ulmaceae Tree
Viburnum spp. Viburnaceae Shrub

The individuals were dispersed across the different zones and were selected consider-
ing seasonal, climatical, and logistical parameters to represent the local species’ biodiversity.

Sampling was conducted during the summer (July 2020), when the climate was dry,
and leaves were exposed to environmental pollution for more than ten days without rain.
Approximately 400 cm2 of leaves per species were sampled, always selecting leaves fully
exposed to the surrounding air. The samples were stored in paper bags and taken to the
laboratory to be analyzed.
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2.3. The Leaf Covering by PMx Using Light Microscopy

Two squares (1 cm) per leaf of each sample were analyzed adaxially under a light
microscope (10×). The pictures were then processed using ImageJ software (https://imagej.
net/ij/) [18] to verify the percentage of leaf surface covered with PMx (Figure 1A,B). A
threshold (≥1% of the leaf surface covered with PMx) was used to select the species for
further investigation.
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Figure 1. (A) Leaf surface of L. nobilis covered with PMx (black and brown spots). (B) Identification
of PMx with ImageJ. (C) Filtration system consists of glassware connected to pump. (D) Paper filter
with high PMx content after first filtration process.

To quantify particulate matter (PMx) using ImageJ, the following steps were carried
out: First, the scale was set up to ensure accurate measurement. An image containing
a scale bar was opened in ImageJ. Using the Zoom tool, the view was adjusted to focus
closely on the scale bar. With the Line tool, a line was drawn along the length of the scale
bar to match its size. The “Set Scale” option was then selected from the Analyze menu. In
the “Set Scale” dialog box, the known distance of the scale was entered (0.5 in this study).
The “Global” option was checked to apply this scale to all future analyses, and then the
setup was confirmed by clicking “OK”. Next, the quantification of PMx was performed.
The image of interest was opened in ImageJ. From the Plugins menu, “Particle Analysis”
and then “Grid” were selected. The grid type was set to “line” and the area per point
was specified as 100,000 µm2. A random square area within the image was selected for
analysis. The Zoom tool was used to increase the magnification of the selected area. In the

https://imagej.net/ij/
https://imagej.net/ij/
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analysis phase, the “ROI Manager” was accessed by navigating to “Analyze > Tools > ROI
Manager”. The PMx particles were identified and selected using the Magic Wand or Ellipse
tool. Each selected PMx was added to the ROI Manager by clicking “Add” (or using the
shortcut key “T”). This process was repeated for all visible PMx particles, ensuring that the
zoom level remained at 200%. Once all PMx particles were selected and added to the ROI
Manager, the “Measure” button in the ROI Manager window was clicked to generate the
measurements. The resulting data were displayed in a Results window. Finally, the data
were copied from the Results window and pasted into an Excel file for further analysis.

2.4. The Filtration Methodology [9]

After measuring the leaf area, each leaf sample was agitated and washed for 60 s with
150 mL of deionized water. The washing solution was successively filtered using three filters
with specific pore sizes (Sartorius FT-3-104-055 for PMx ≤ 10 µm, Sartorius FT-3-354-110
for PMx ≤ 2.5 µm, and Sartorius 11807-47-N PTFE membrane for PMx ≤ 0.2 µm). Each
filter was dried for 30 min at 60 ◦C, stabilized at a constant relative air humidity (50%) for
60 min, and then pre-weighed. A 47 mm glass filter funnel connected to a vacuum pump
was used to perform the filtration (Figure 1C,D). After filtration, filters were dried again,
stabilized at a controlled temperature, and weighed again. The concentration of each PMx
size was expressed in µg cm−2.

2.5. Leaf Traits

High-resolution images of three leaves per sample were taken against a white back-
ground and processed using ImageJ to measure the following traits: leaf surface area
(LA in cm2), specific leaf area (SLA in m2 kg−1) calculated as the leaf area (m2) per unit
leaf dry matter (kg−1), leaf dissection index (LDI = leaf perimeter/

√
leaf area), and leaf

roundness (leaf roundness = (4 × leaf area)/[π × (major axis)]). Leaf mass per area (LMA)
was determined using five discs (8 mm) per leaf of each sample, dried until constant weight,
and used to calculate SLA.

2.6. Statistical Analysis

The correlation between both methodologies was verified using linear regression,
including the data from the 30 species studied. To ensure consistency in the comparison of
methodologies, pooled leaf samples from each species were used for analysis rather than
multiple samples per species, as the study’s primary focus was on evaluating methodologi-
cal differences rather than inter-species variation.

Eight species were selected to perform multiple linear regression (MLR) between the
leaf traits and PMx accumulation factors to infer the contribution of leaf traits to the species’
capacity to accumulate PMx. These species were chosen because they were collected on
the same day and in the same city zone (UT), ensuring exposure to similar levels of air
pollution, which is necessary for predicting the plant species’ net particle accumulation
ability [14]. The statistical analysis was performed using Origin (Pro), version 2023b (Origin
Lab Corporation, Northampton, MA, USA).

3. Results

Figure 2 presents the values of PM10 and PM2.5 in the study region during the summer
of 2020. The PM10 reference limit of 50 µg/m3 was not exceeded, and the PM2.5 levels were
considered low for the period.

Out of the 30 species collected, 18 had more than 1% of their leaf area covered with
PMx and were selected for the filtration methodology (Figure 3B). The filtration method
was applied to quantify the amount of PMx in the leaves of the 16 selected species: E. japon-
icus, L. lucidum, A. glutinosa, R. ulmifolius, L. nobilis, O. europaea, T. x europaea, A. saccha-
rinum, A. campestre, T. cordata, P. laurocerasus, P. nigra, S. cinerea, P. serrulata, Q. ilex, and
R. chinensis. Two species (Viburnum sp. and U. minor) presented unrealistic data (total
PMx > 100 µg cm−2) and were excluded from the results. For Viburnum sp., the leaves were
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sampled from an individual located very close to a high-traffic road, possibly leading to
dust contamination and analytical errors. The U. minor samples were contaminated by a
fungus, likely causing quantification errors.
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The 14 species not selected were A. negundo, S. cinerea, A. campestre, G. biloba, P. domes-
tica, I. walleriana, F. viridissima, N. oleander, S. japonicum, C. australis, G. procumbens, P. alba,
U. glabra, and L. latifolia.

The results of the filtration are presented in Figure 3A. The species with the highest to-
tal PMx accumulation (>50 µg cm−2) were E. japonicus, L. lucidum, A. glutinosa, R. ulmifolius,
and L. nobilis. Among these, E. japonicus, A. glutinosa, and L. lucidum also showed high
values of PMx > 10 µm (>50 µg cm−2). The highest accumulators for PMx accumulation
are between 2.5 and 10 µm (>10 µg cm−2). The species with the highest PMx accumulation
between 2.0 and 2.5 µm (>10 µg cm−2) were E. japonicus, R. ulmifolius, and L. lucidum.

The linear regression between the two analyses presented a high coefficient of deter-
mination (R2 = 0.72), with statistical significance (p > 0.001) and linearity confirmed by a
homogeneous distribution of the predicted and residual values (Figure 4).

Representative values of leaf traits for each species are presented in Table 2 (Part 1).
The MLR analysis confirmed that a combination of leaf traits influenced PMx accumulation
(Table 2, Part 2). The percentage of PMx was positively associated with leaf roundness but
showed a negative relationship with both LA and SLA. Total PMx exhibited a negative
correlation with SLA, while PM10 did not correlate with any leaf trait. PM2.5 was positively
associated with LDI and negatively with LA and SLA, whereas PM0.2 was negatively
correlated with LA.
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Table 2. Part 1. Leaf traits of the species analyzed: leaf area (LA cm2), specific leaf area (SLA m2 kg−1),
leaf dissection index (LDI, dimensionless), and leaf roundness (dimensionless). Species highlighted
in bold are those selected for the multiple regression analysis. Part 2. Multiple linear regression
(MLR) on total PMx (µg cm−2), leaf covered with PMx (%), PM10 (µg cm−2), PM2.5 (µg cm−2), and
PM0.2 (µg cm−2) indicating the effect of leaf traits: LA, SLA, LDI, and leaf roundness. Determination
coefficient (R2); statistical significance (p-level); positive relationship (+); negative relationship (-); and
variable not included in the linear model (ni). Significant effects (p-value < 0.1) are shown in bold.

Part 1 Species LA SLA LDI Leaf
Roundness

E. japonicus 5.59 7.49 6.35 0.62
L. lucidum 27.57 6.49 5.00 0.43
A. glutinosa 54.81 14.03 5.53 1.00
R. ulmifolius 6.37 9.29 4.97 0.39
L. nobilis 19.27 8.17 5.16 0.29
O. europaea 5.19 7.15 6.60 0.17
Tilia x europaea 47.39 18.69 6.65 0.83
A. saccharinum 46.63 12.65 12.29 0.50
A. campestre 32.85 14.22 5.79 0.68
T. cordata 75.56 15.95 6.13 0.99
P. laurocerasus 85.48 8.52 5.09 0.36
P. nigra 39.02 12.08 7.29 0.77
S. cinerea 33.44 9.72 6.04 0.45
P. serrulata 29.42 8.17 4.85 0.56
Q. ilex 12.11 9.57 5.42 0.41
R. chinensis 8.21 21.20 4.71 0.60

Part 2 Variable Correlation R2 p-Level

% PMx LA - 0.26 0.072
SLA - 0.69 0.022
LDI ni 0.52 0.422
Leaf roundness + 0.66 0.016

Total PMx LA ni 0.26 0.104
SLA - 0.69 0.093
LDI ni 0.52 0.551
Leaf roundness ni 0.66 0.152

PM10 LA ni 0.26 0.188
SLA ni 0.69 0.112
LDI ni 0.52 0.809
Leaf roundness ni 0.66 0.121

PM2.5 LA - 0.26 0.034
SLA - 0.69 0.072
LDI + 0.52 0.099
Leaf roundness ni 0.66 0.745

PM0.2 LA - 0.26 0.054
SLA ni 0.69 0.541
LDI ni 0.52 0.347
Leaf roundness ni 0.66 0.655

4. Discussion

The PMx levels in the sampling region during the summer of 2020 remained within the
reference limits. This can be attributed to the expansion of the atmospheric boundary layer,
which promotes aerosol dispersion [17]. Gualtieri et al. [19] also note that during summer,
the accumulation of PM10 is more influenced by the high variability of meteorological
conditions than by anthropogenic emissions. Moreover, there is a significant decrease
in combustion processes related to agricultural biomass and domestic heating during
this season.

Light microscopy proved effective for visualizing PMx deposition on leaves. Although
the procedure is simple and inexpensive, it is time-consuming. Its results are comparable to
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those obtained by scanning electron microscopy (SEM), which is more complex, costly, and
equally time-consuming, with similar values of leaf coverage (not exceeding 4%) reported
by both methods [20].

The values obtained using the filtration methodology were consistent with the litera-
ture [13,21,22]. The high total PMx values in this study may be attributed to the method
being performed without prior filtration through a sieve to eliminate particles larger than
100 µm. However, this approach might restrict the possibility of having reliable results
regarding the accumulation of PM10; the decision to follow this method was made to ensure
comparability between the methodologies.

The linear regression analysis confirmed that both methodologies (light microscopy
and filtration) are comparable when leaves have more than 1% of their surface covered
with PMx. However, based on our results, we hypothesize that the regression might not
be significant for leaves with less than 1% coverage. Light microscopy can underestimate
values, as visualization might bias particle size identification if samples appear to have
minimal PMx.

Both methodologies have their pros and cons. Light microscopy may be inaccurate
for species with trichomes obstructing visualization [21]. However, it is advantageous for
identifying potential analytical errors, such as pathogen contamination, and for screening
samples to select leaves with varying PMx deposition levels.

The filtration method can overestimate PMx accumulation in plant species that release
leaf structures like trichomes during vigorous washing. Additionally, particles forming
agglomerates might not accurately reflect particle size fractions (Hofman et al., 2014), and
water-soluble particles are not accounted for [23]. This method may also lack sensitivity for
quantifying PM0.2 due to its low weight; nevertheless, the methodology is fast, low-cost,
and practical for processing many samples [21].

The plant community under investigation exhibited a wide range of foliar traits, and
the accumulation of PMx was negatively correlated with SLA and LA. Plant species with
low SLA and high PMx accumulation likely have more extended leaf longevity or higher
leaf wettability (high wettability = high PMx accumulation). SLA has been recommended
as a crucial and easy-to-measure leaf trait for distinguishing between species that are low
and high net particle accumulators [14]. Moreover, recent research in the same region
has shown that species with lower LA [12] and more intricate branch architectures have a
greater ability to entrap PMx [24]. This finding is further supported by Manzini et al. [25],
who reported that a complex shoot and leaf arrangement is a key factor in PMx deposition.

Understanding the influence of leaf morphology on PMx accumulation is crucial for
elucidating species’ differential capacities for PMx deposition. On one hand, deciduous
species with smaller foliar dimensions and more intricate branch architectures might entrap
high levels of PMx [24]. On the other hand, a recent comprehensive review synthesizing
data on tree traits and PMx accumulation across diverse species and geographical locations
revealed that evergreen conifer needle leaves, as well as small rough leaves, waxy coatings,
and high-density trichomes, are potentially beneficial for PMx capture [26,27]. However,
the study finds no consistent evidence to identify the most influential trait due to the
diversity in sampling methods and other factors [27].

Additionally, environmental factors can influence leaf traits [28,29], and growth rate
may significantly impact element deposition [20]. Specifically, the density of branches and
leaves was found to be the most significant factor affecting PMx retention, with negative
effects, suggesting that crown morphological structure is more critical than leaf morphology
in screening tree species for efficient PM retention [30].

5. Conclusions

This study investigated the effectiveness of various plant species in accumulating
PMx to mitigate urban air pollution. Our findings highlight significant differences in
PMx accumulation capacities among the studied species, emphasizing the importance of
selecting appropriate plant species for urban green spaces to enhance air quality.
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Our findings revealed significant disparities in PMx capture capabilities among dif-
ferent plant species, underscoring the importance of promoting diverse plant ecosystems
within urban landscapes. Among the species analyzed, Euonymus japonicus, Ligustrum
lucidum, Alnus glutinosa, Rubus ulmifolius, and Laurus nobilis demonstrated the highest
total PMx accumulation, exceeding 50 µg cm−2. These species also exhibited high values
of PMx > 10 µm, indicating their substantial role in capturing larger particulate matter.
Specifically, Euonymus japonicus and Ligustrum lucidum were notable for their efficiency
in capturing PMx between 2.0 and 2.5 µm. Additionally, the correlation between leaf
traits and PMx accumulation was shown to be important when selecting plant species
PMx deposition.

Based on our comprehensive research framework and findings, we conclude that
PMx accumulation on leaves is most accurately understood when multiple quantification
methods are employed concurrently. Our hypothesis of a high correlation between the two
methods was supported, demonstrating that different techniques elucidate various aspects
of PMx deposition. By comparing data from these methods, researchers can select the most
suitable technique based on laboratory capacity and sample size. For instance, filtration
methods are particularly effective for large sample sizes, while light microscopy serves as
an efficient screening tool for identifying target samples, as demonstrated in our study.

The next step in this research involves a more detailed investigation of the underly-
ing mechanisms that contribute to the high PMx accumulation capacity of plant species.
Future studies should focus on the physiological and morphological traits that enhance
particulate matter capture. Additionally, long-term field studies are necessary to evaluate
the effectiveness of these species in different environmental conditions and seasons.
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